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Contents of Package:

B D-Link AirPlus XTREME G+ DI-624+
High-Speed 2.4GHz Wireless Router

m Power Adapter-DC 5V, 2.5A

m Manual and Warranty on CD

m Quick Installation Guide

m Ethernet Cable (All the DI-624+'s Ethernet ports are Auto-MDIX)

Note: Using a power supply with a different voltage rating than the one included with the
DI-624+will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:
B Ethernet-Based Cable or DSL Modem

B Computers with Windows, Macintosh, or Linux-based
operating systems with an installed Ethernet adapter

B Internet Explorer Version 6.0 or Netscape Navigator
Version 6.0 and Above



Introduction

The D-Link AirPlus Xtreme G+ DI-624+ High-Speed Wireless Router is an 802.11g high-
performance, wireless router that supports high-speed wireless networking at home, at
work or in public places.

Unlike most routers, the DI-624+ provides data transfers at up to 8X (compared to the
standard 11 Mbps) when used with other D-Link AirPlus Xtreme G products. The 802.11g
standard is backwards compatible with 802.11b products. This means that you do not
need to change your entire network to maintain connectivity. You may sacrifice some of
802.119g’s speed when you mix 802.11b and 802.11g devices, but you will not lose the
ability to communicate when you incorporate the 802.11g standard into your 802.11b
network. You may choose to slowly change your network by gradually replacing the 802.
11b devices with 802.11g devices .

In addition to offering faster data transfer speeds when used with other 802.11g products,
the DI-624+ has the newest, strongest, most advanced security features available today.
When used with other 802.11g WPA (WiFi Protected Access) and 802.1x compatible
products in a network with a RADIUS server, the security features include:

WPA *Available around Q4/2003 as a free download.: Wi-Fi Protected Access authorizes
and identifies users based on a secret key that changes automatically at a
regular interval. WPA uses TKIP (Temporal Key Integrity Protocol) to change
the temporal key every 10,000 packets (a packet is a kind of message transmitted
over a network.) This insures much greater security than the standard WEP
security. (By contrast, the older WEP encryption required the keys to be changed
manually.)

802.1x*Available around Q4/2003 as a free download.: Authentication is a first line of
defense against intrusion. In the Authentication process the server verifies the
identity of the client attempting to connect to the network. Unfamiliar clients
would be denied access.

For home users that will not incorporate a RADIUS server in their network, the security
for the DI-624+, used in conjunction with other 802.11g products, will still be much
stronger than ever before. Utilizing the Pre Shared Key mode of WPA, the DI-624+ will
obtain a new security key every time it connects to the 802.11g network. You only need
to input your encryption information once in the configuration menu. No longer will you
have to manually input a new WEP key frequently to ensure security, with the DI-624+,
you will automatically receive a new key every time you connect, vastly increasing the
safety of your communications.



Connections

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you can
use either a straight-through or a
crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX

LAN port The Auto MDI/ Receptor
t rﬁot- ; llv sen MDIX WAN port is for the
S B A the connection for Power

the cable type when
connecting to
Ethernet-enabled
computers.

the Ethernet cable Adapter
to the Cable or
DSL modem




LEDs
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Features

Fully compatible with the 802.11g standard to provide a wireless data rate of
up to 54Mbps

Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

WPA*Available around Q4/2003 as a free download. (Wi Fi Protected Access)
authorizes and identifies users based on a secret key that changes automati-
cally at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring greater
security

M Pre Shared Key mode means that the home user, without a RADIUS
server, will obtain a new security key every time the he or she connects
to the network, vastly improving the safety of communications on the
network.

802.1x *Available around Q4/2003 as a free download. Authentication in
conjunction with the RADIUS server verifies the identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing)

User-friendly configuration and diagnostic utilities

Operates in the 2.4GHz frequency range

Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection

Advanced Firewall features

H Supports NAT with VPN pass-through, providing added security
B MAC Filtering

M IP Filtering

B URL Filtering

B Domain Blocking
Bl Scheduling

DHCP server supported enables all networked computers to automatically
receive IP addresses

Web-based interface for Managing and Configuring

Access Control to manage users on the network

Supports special applications that require multiple connections
Equipped with 4 10/100Mbps Ethernet ports, 1 WAN port, Auto MDI/MDIX
7



Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless networking
brings.

A WLAN is a cellular computer network that transmits and receives data with radio
signals instead of wires. WLANs are used increasingly in both home and office
environments, and public areas such as airports, coffee shops and universities. Innovative
ways to utilize WLAN technology are helping people to work and communicate more
efficiently. Increased mobility and the absence of cabling and other fixed infrastructure
have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as Ethernet
adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANSs are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANSs ease of implementation.
WLANSs can operate in locations where installation of wiring may be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and
easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home or
office.

Scalability — WLANs can be configured in a variety of topologies to meet the needs of
specific applications and installations. Configurations are easily changed and range from
peer-to-peer networks suitable for a small number of users to larger infrastructure networks
to accommodate hundreds or thousands of users, depending on the number of wireless
devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology
The DI-624+ Wireless Broadband Router utilizes the new 802.11g standard.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the
data rate up to 54 Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

The DI-624+ is backwards compatible with 802.11b devices. This means that if you have
an existing 802.11b network, the devices in that network will be compatible with 802.11g

devices at speeds of up to 11Mbps in the 2.4GHz range.



Wireless Basics (continued)

Installation Considerations

The D-Link AirPlus Xtreme G+ DI-624+ lets you access your network, using a wireless
connection, from virtually anywhere within its operating range. Keep in mind, however,
that the number, thickness and location of walls, ceilings, or other objects that the
wireless signals must pass through, may limit the range. Typical ranges vary depending
on the types of materials and background RF (radio frequency) noise in your home or
business. The key to maximizing wireless range is to follow these basic guidelines:

1 Keep the number of walls and ceilings between the DI-624+ and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

7 Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

3 Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

/. Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

10



Getting Started

Cable/DSL Modem

-DI-624 +

| High-Spéed 2,40H:

Wineless Broadband Router

A

Computer 1 \/
eskton PC o iptop s @
‘6 [ﬂmputfr 2
leskiop PCor Lapiog

Please remember that D-Link |AirPlus Xtreme G+ wireless|devices are pre-
configured to connect together, right out of/ the box, with their default settings.

For a typical wireless setup at home (as shown above),
please do the following:

o You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office)

e Consult with your Cable or DSL provider for proper installation of the modem

Connect the Cable or DSL modem to the DI-624+ Wireless Broadband Router
(see the printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link
AirPlus Xtreme G+ DWL-G520+ wireless PCI adapter into an available PCI slot
on your desktop computer. You may also install the DWL-520+.

(See the printed Quick Installation Guide included with the network adapter.)

Install the D-Link DWL-G650+ wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the DWL-G650+.)

Ethernet LAN ports of the DI-624+ are Auto MDI/MDIX and will work with both
Straight-Through and Cross-Over cable.
(See the printed Quick Installation Guide included with the DFE-530TX+.) 11

0 Install the D-Link DFE-530T X+ adapter into a desktop computer. The four



Using the Configuration Menu

Whenever you want to configure your network or the
DI-624+, you can access the Configuration Menu by
opening the web-browser and typing in the IP Address
of the DI-624+. The DI-624+ default IP Address is

shown at right:
| Open the web browser
| Type in the IP Address of
the Router (http://192.168.0.1)

Note: if you have changed the default IP Address assigned
to the DI-624, make sure to enter the correct IP Address.

[ ] Type admin in the User
Name field
u Leave the Password blank

[ | Click OK

Home > Wizard

The Home>Wizard
screen will appear.
Please refer to the
Quick Installation
Guide for more infor-
mation regarding the
Setup Wizard.

€

{{314[A

LAW

i

L

These buttons appear
on most of the configu-
ration screens in this
section. Please click on
the appropriate button
at the bottom of each
screen after you have
made a configuration
change.
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Using the Configuration Menu (continued)

SSID-

Channel-

WEP-

WEP Encryption-

Key Type-

Keys 1-4-

Home > Wireless

High-Speed 2.4GHz Wireless Rouler

D624+ F )
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Hagd ' |

Service Set Identifier (SSID) is the name designated for a spe-
cific wireless local area network (WLAN). The SSID’s factory
default setting is default. The SSID can be easily changed to
connect to an existing wireless network or to establish a new
wireless network.

6 is the default channel. All devices on the network must share
the same channel. (Note: The wireless adapters will automati-
cally scan and match the wireless setting.)

Wired Equivalent Privacy (WEP) is a wireless security protocol
for Wireless Local Area Networks (WLAN). WEP provides secu-
rity by encrypting the data that is sent over the WLAN. Select
Enabled or Disabled. Disabled is the default setting. (Note: If
you enable encryption on the DI-624+ make sure to also enable
encryption on all the wireless clients or wireless connection will
not be established.)

Select the level of encryption desired: 64-bit, or 128-bit

Select HEX or ASCII

Input up to 4 WEP keys; select the one you wish to use.
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Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/
Secondary DNS
Address-

MTU-

Home > WAN > Dynamic IP Address

High-Speed 240 Hz Wineless Router
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Choose Dynamic IP Address to obtain IP Address information
automatically from your ISP. Select this option if your ISP does
not give you any IP numbers to use. This option is commonly
used for Cable modem services.

The Host Name is optional but may be required by some ISPs.
The default host name is the device name of the Router and may
be changed.

The default MAC Address is set to the WAN'’s physical inter-
face MAC address on the Broadband Router. It is not recom-
mended that you change the default MAC address unless re-
quired by your ISP.

The default MAC address is set to the WAN's physical interface
MAC address on the Broadband Router. You can use the “Clone
MAC Address” button to copy the MAC address of the Ethernet
Card installed by your ISP and replace the WAN MAC address
with the MAC address of the router. It is not recommended that
you change the default MAC address unless required by your
ISP.

Enter a DNS Address if you do not wish to use the one
provided by your ISP.

Enter an MTU value only if required by your ISP. Otherwise, leave
it a the default setting. 14



Using the Configuration Menu (continued)

Static IP Address-

IP Address-

Subnet Mask-

ISP
Gateway Address-

Primary
DNS Address-

Secondary
DNS Address-

MTU-

Home > WAN > Static IP Address
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Choose Static IP Address if all WAN IP information is provided to
you by your ISP. You will need to enter in the IP address, subnet
mask, gateway address, and DNS address(es) provided to you
the fields must be in the
appropriate IP form, which are four octets separated by a dot (x.
x.x.X). The Router will not accept the IP address if it is not in this

by your ISP. Each IP address entered in
format.
Input the public IP Address provided by

Input your Subnet mask. (All devices in
the same subnet mask.)

Input the public IP address of the ISP
connecting

your ISP

the network must have

to which you are

Input the primary DNS (Domain Name Server) IP address

provided by your ISP

This is optional

Enter an MTU value only if required by your ISP. Otherwise, leave

it at the default setting.
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Using the Configuration Menu (continued)

Please be sure to
remove any
existing
PPPOE client
software
installed on your
computers.

Choose PPPoE (Point
to Point Protocol over
Ethernet) if your ISP
uses a PPPoOE
connection. Your ISP
will provide you with a
username and
password. This option
is typically used for
DSL services. Select
Dynamic PPPOE to ob-
tain an IP address au-
tomatically for your
PPPoOE connection.
Select Static PPPoE
to use a static IP ad-
dress for your PPPoeE
connection.

PPPOE-

User Name-

Retype Password-

Service Name-
IP Address-

Primary DNS
Address-

Secondary DNS
Address-

Home > WAN > PPPoE

MH-624- |
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Choose this option if your ISP uses PPPoE. (Most DSL users
will select this option.)

Dynamic PPPoE- receive an IP Address automatically from your ISP.
Static PPPoE-you have an assigned (static) IP Address.

Your PPPoE username provided by your ISP.

Re-enter the PPPoE password

Enter the Service Name provided by your ISP (optional).

This option is only available for Static PPPoOE. Enter the static
IP Address for the PPPOE connection.

Primary DNS IP address provided by our ISP

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPOE connection.

(Continued on the next page) 16



Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

MTU-

Auto-reconnect-

Maximum Transmission Unit-1492 is the default setting-you may
need to change the MTU for optimal performance with your spe-
cific ISP.

If enabled, the DI-624+ will automatically connect to your ISP
after your system is restarted or if the PPPoOE connection is
dropped.

Home > LAN

— us o

High-5peed 2.00H: Wireless Router
=624+
Tha P ackiress of the DRGSR+
#
—' Subrad Sfank E“-'\E 55 "‘:\-E
Wi e Dosven Mame | laptionsl)
pem— 990
WAN Apoly Concel Help

E

i

LAN is short for Local Area Network. This is considered your internal network. These are
the IP settings of the LAN interface for the DI-624+. These settings may be referred to as
Private settings. You may change the LAN IP address if needed. The LAN IP address is
private to your internal network and cannot be seen on the Internet.

IP Address-

Subnet Mask-

Local Domain-

The IP address of the LAN interface. The default IP address is:
192.168.0.1

The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0

This field is optional. Enter in the local domain name.

17



Using the Configuration Menu (continued)

Home > DHCP
AirPlus -
High-fpoed 2.40Hz Wireluss Router
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DHCP stands for Dynamic Host Control Protocol. The DI-624+ has a built-in DHCP server.
The DHCP Server will automatically assign an IP address to the computers on the LAN/
private network. Be sure to set your computers to be DHCP clients by setting their TCP/
IP settings to “Obtain an IP Address Automatically.” When you turn your computers on,
they will automatically load the proper TCP/IP settings provided by the DI-624+. The
DHCP Server will automatically allocate an unused IP address from the IP address pool
to the requesting computer. You must specify the starting and ending address of the IP

address pool.

DHCP Server-

Starting
IP Address-

Ending
IP Address-

Lease Time-

Select Enabled or Disabled. The default setting is Enabled.

The starting IP address for the DHCP server’s IP assignment

The ending IP address for the DHCP server’s IP assignment

The length of time for the IP lease. Enter the Lease time. The
default setting is one hour

18



Using the Configuration Menu (continued)

Advanced > Virtual Server

DI-624+ -
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The DI-624+ can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP address can be automatically redirected to local
servers in the LAN (Local Area Network).

The DI-624+ firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the DI-624+ are invisible to the outside
world. If you wish, you can make some of the LAN computers accessible from the
Internet by enabling Virtual Server. Depending on the requested service, the DI-624+

redirects the external service request to the appropriate server within the LAN network.

The DI-624+ is also capable of port-redirection meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular
virtual service.

19



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Server-
Name-

Private IP-

Protocol Type-

Private Port-

Public Port-

Schedule-

Example #1.:

Select Enabled or Disabled
Enter the name referencing the virtual service

The server computer in the LAN (Local Area Network) that will be
providing the virtual services.

The protocol used for the virtual service

The port number of the service used by the Private IP computer

The port number on the WAN (Wide Area Network) side that will
be used to access the virtual service.

The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is setto Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will
be disabled.

If you have a Web server that you wanted Internet users to
access at all times, you would need to enable it. Web (HTTP)
server is on LAN (Local Area Network) computer 192.168.0.
25. HTTP uses port 80, TCP.

Name: Web Server

Private IP: 192.168.0.25

Protocol Type: TCP

Private Port: 80

Public Port: 80

Schedule: always

20



Using the Configuration Menu (continued)
Advanced > Virtual Server continued

Virtual Servers List
Marme Private IP Protocal cchedule
X wirtual Server HTTR 192.168.0.25 TCP 80/80 always E{

jh Click on this icon to edit the virtual service

.'" 1] Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port 2100
and only during the weekends, you would need to enable it as such. FTP server is on
LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun
All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of

port redirection and can be useful in cases where there
are many of the same servers on the LAN network.

21
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Using the Configuration Menu (continued)
Advanced > Applications
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Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties
working through NAT (Network Address Translation). Special Applications makes
some of these applications work with the DI-624+. If you need to run applications that
require multiple connections, specify the port normally associated with an application
in the “Trigger Port” field, select the protocol type as TCP or UDP, then enter the
public ports associated with the trigger port to open them for inbound traffic.

The DI-624+ provides some predefined applications in the table on the bottom of the
web page. Select the application you want to use and enable it.

Note! Only one PC can

Name:

Trigger Port:

Trigger Type:
Public Port:

Public Type:

use each Special Application tunnel.
This is the name referencing the special application.

This is the port used to trigger the application. It can be either
a single port or a range of ports.

This is the protocol used to trigger the special application.

This is the port number on the WAN side that will be used to
access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

This is the protocol used for the special application.
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters
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ture |00 =] - |00 =] [20a =] o [00 =] . [00 =] [am =]
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Apply Cancel Help
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Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-624+ can be setup to deny internal computers by their IP or MAC
addresses. The DI-624+ can also block users from accessing restricted web sites.

IP Filters: Use IP Filters to deny LAN IP addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP address.

IP: The IP address of the LAN computer that will be denied
access to the Internet.

Port: The single port or port range that will be denied access to the
Internet.

Protocol Type: Select the protocol type

Schedule: This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu (continued)

Advanced > Filters > URL Blocking
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URL Blocking is used to deny LAN computers from accessing specific web sites by
the URL. A URL is a specially formatted text string that defines a location on the
Internet. If any part of the URL contains the blocked word, the site will not be
accessible and the web page will not display. To use this feature, enter the text string
to be blocked and click Apply. The text to be blocked will appear in the list. To

delete the text, just highlight it and click Delete.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu (continued)
Advanced > Filters > MAC Filters
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Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Network. You can either manually
add a MAC address or select the MAC address from the list of clients that are currently
connected to the Broadband Router.

Filters- Select the filter you wish to use; in this case, MAC filters was
chosen.

MAC Filters- Choose Disable MAC filters; allow MAC addresses listed below;
or deny MAC addresses listed below.

Name- Enter the name here.

MAC Address- Enter the MAC Address.

DHCP Client- Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu(continued)
Advanced > Filters > Domain Blocking
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Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to a
specific domain such as http and ftp. It can also allow computers to access specific
sites and deny all other sites.

Filters- Select the filter you wish to use; in this case, Domain Blocking
) ) was chosen.
Domain Blocking-
Disabled- Select Disabled to disable Domain Blocking
Allow- Allows users to access all domains except Blocked Domains
Deny- Denies users access to all domains except
Permitted Domains
Permitted
Domains- Enter the Permitted Domains in this field

Blocked Domains- Enter the Blocked Domains in this field
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Using the Configuration Menu (continued)
Advanced > Firewall
"Aﬁiﬁlm =
HWMﬁdﬁtr

| Home VLTI Tools — Stafus 8 Helg |

Firowal Hidus co o toa 10 olios ot dany Ty Wom pacsieg Ihovgh the 1520+

" Ershied © Drablag
Acim B Blrw © Desy

Inlirface P Harga Siad P Ranga Exd Frelocal  Fod Range
swen [ &P F
Basimabin [ ZJF F A .

Sobdehs 7 Ao

™ From ilmﬁa 'T:I_[F"E'I !-'E'E‘ F’FE"E

day |Bun 5| I\-Elllﬂ
Agpty Cancel Help
Actien Rasma Savma Disiinaiion Prriacol

I

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-624+. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-624+. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contain all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note:
The DI-624+ MAC Address filtering rules have precedence over the Firewall Rules.

Firewall Rules- Enable or disable the Firewall

Name- Enter the name

Action- Allow or Deny

Source- Enter the IP Address range
Destination- Enter the IP Address range; the Protocol;

and the Port Range

Schedule- Select Always or enter the Time Range.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link’

Building Metworks for People

AirPlus >
stl-
High-Speed 2.4GHz Wireless Router

DI-624+ .
| TETY  Advanced [EETT TR T I
DME [Demilitarized Zong) is used to allow 2 singde comaputer on the LAN to be exposed to
P — the kitemet,
¥irtual Server
€ Enabled & Dizabled
P IP Address ; E'
Applicaticns
Filters v/ L+
Apply Cancel Help
f Firewall
DMZ
Performance

If you have a client PC that cannot run Internet applications properly from behind the
DI-624+, then you can set the client up for unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of
security risks, so only use this option as a last resort.

DMZ- Enable or Disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the internet. By
default the DMZ is disabled.

IP Address- Enter the IP Address of the computer to be in the DMZ
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Using the Configuration Menu (continued)

Advanced > Performance
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Beacon Interval-  Beacons are packets sent by an Access Point to synchronize a

wireless network. Specify a value. 100 is the default setting and
is recommended.

RTS Threshold- This value should remain at its default setting of 2432. If inconsis-
tent data flow is a problem, only a minor modification should be
made.

Fragmentation- The fragmentation threshold, which is specified in bytes, deter-
mines whether packets will be fragmented. Packets exceeding
the 2346 byte setting will be fragmented before transmission.
2346 is the default setting

DTIM interval- (Delivery Traffic Indication Message) 3 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

8X Mode- By activating this mode, the device can transmit and receive data
up to eight (8) times of the 802.11b speed with a similar 8X device.

Mixed Mode- This mode support all range of data transmission and receiving
mode, including 802.11b, 802.11b+, 802.11g and 802.11g+ .
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Using the Configuration Menu (continued)

Tools> Admin
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At this page, the DI-624+ administrator can change the system password. There are two
accounts that can access the Broadband Router’'s Web-Management interface. They are
admin and user. Admin has read/write access while user has read-only access. User can
only view the settings but cannot make any changes.

Administrator- admin is the Administrator login name
Password- Enter the password and enter again to confirm
User- user is the User login name

Password- Enter the password and enter again to confirm

Remote Management- Remote management allows the DI-624+ to be configured
from the Internet by a web browser. A username and password is still required to access
the Web-Management interface. In general, only a member of your network can browse
the built-in web pages to perform Administrator tasks. This feature enables you to per-
form Administrator tasks from the remote (Internet) host.

IP Address- The Internet IP address of the computer that has access to the Broadband
Router. If you input an asterisk (*) into this field, then any computer will be able to access
the Router. Putting an asterisk (*) into this field would present a security risk and is not
recommended.

Port- The port number used to access the Broadband Router.

Example- http://x.x.x.x:8080 where x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Mangement interface.
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Using the Configuration Menu (continued)

Time Zone-
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Select the Time Zone from the pull-down menu.

NTP is short for Network Time Protocol. NTP synchronizes com-
puter clock times in a network of computers.
This field is optional.

To manually input the time, enter the values in these fields for the
Year, Month, Day, Hour, Minute, and Second. Click Set Time.

To select Daylight Saving time manually, select enabled or dis-
abled, and enter a start date and an end date for daylight saving
time.
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Using the Configuration Menu (continued)

Tools > System

D-Link
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The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file can be loaded back on the Broadband Router. To reload
a system settings file, click on Browse to browse the local hard drive and locate the
system file to be used. You may also reset the Broadband Router back to factory set-
tings by clicking on Restore.

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load

Restore to Factory
Default Settings-  Click Restore to restore the factory default settings
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Using the Configuration Menu (continued)

Tools > Firmware
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You can upgrade the firmware of the Router here. Make sure the firmware you want to use
is on the local hard drive of the computer. Click on Browse to browse the local hard drive
and locate the firmware to be used for the update. Please check the D-Link support site
for firmware updates at http://support.dlink.com or global websites. You can download
firmware upgrades to your hard drive from the D-Link support site.

Firmware Upgrade- Click on the link in this screen to find out if there is an updated
firmware; if so, download the new firmware to your hard drive.

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart
Device-

Block
WAN
Ping-

UPNP-

Gaming
Mode-

Dynamic
DNS-

VPN
Pass
Through-

Tools > Misc
The Ping Test is used to
send Ping packets to test if S
a computer is on the
Internet. Enter the IP Ad-
dress that you wish to Ping,
and click Ping

Click Reboot to restart the
DI-624+

0 DgELe’

If you choose to block WAN
Ping, the WAN IP Address of
the DI-624+ will not respond
to pings. Blocking the Ping .
may provide some extra se- G PP
curity from hackers.

Discard Ping from Fapy
WAN side-

Click Enabled to block the "
WAN ping 289

To use the Universal Plug and Play feature click on Enabled. UPNP
provides compatibility with networking equipment, software and periph-
erals of the over 400 vendors that cooperate in the Plug and Play forum.

Gaming mode allows a form of pass-through for certain Internet Games.
If you are using Xbox, Playstation2 or a PC, make sure you are using the
latest firmware and Gaming Mode is enabled. To utilize Gaming Mode,
click Enabled. If you are not using a Gaming application, it is recom-
mended that you Disable Gaming Mode.

Dynamic Domain Name System is a method of keeping a domain name
linked to a changing IP Address. This is a useful feature since many
computers do not use a static IP address.

The DI-624+ supports VPN (Virtual Private Network) pass-through
for both PPTP (Point-to-Point Tunneling Protocol) and IPSec (IP
Security). Once VPN pass-through is enabled, there is no need
to open up virtual services. Multiple VPN connections can be
made through the DI-624+. This is useful when you have many
VPN clients on the LAN network.

PPTP- select Enabled or Disabled

IPSec- select Enabled or Disabled 34



Using the Configuration Menu (continued)

Status > Device Info
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This page displays the current information for the DI-624+. It will display the LAN, WAN
and MAC address information.

If your WAN connection is set up for a Dynamic IP address then a Release button and
a Renew button will be displayed. Use Release to disconnect from your ISP and use
Renew to connect to your ISP.

If your WAN connection is set up for PPPoE, a Connect button and a Disconnect button
will be displayed. Use Disconnect to drop the PPPoE connection and use Connect to
establish the PPPoE connection.

This window will show the DI-624+'s working status:

WAN IP Address: WAN/Public IP Address
Subnet Mask: WAN/Public Subnet Mask
Gateway: WAN/Public Gateway IP Address
Domain Name Server: WAN/Public DNS IP Address
WAN Status: WAN Connection Status

LAN IP Address: LAN/Private IP Address of the DI-624+
Subnet Mask: LAN/Private Subnet Mask of the DI-624+

Wireless MAC Address: Displays the MAC address
SSID: Displays the current SSID
Channel: Displays the current channel
WEP: indicates whether WEP is enabled or disabled
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Using the Configuration Menu (continued)

Status > Log
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The Broadband Router keeps a running log of events and activities occurring on the Router.
If the device is rebooted, the logs are automatically cleared. You may save the log files

under Log Settings.

DHCP Discover

View Log- First Page - The first page of the log
Last Page - The last page of the log
Previous - Moves back one log page
Next - Moves forward one log page
Clear - Clears the logs completely
Log Settings - Brings up the page to configure the log

Tirne Meszangs Source Destination Mude
Dec/27r2002 17:0%:11 DHCF Request success 10.80.1 5
Decf27r2002 17.058.11 DHCF BEequest 1020, 1.54

DHCP Discover
Drecf272002 17:08:07  System started.
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Using the Configuration Menu (continued)

Status > Log > Log Settings
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Not only does the Broadband Router display the logs of activities and events, it can setup
to send these logs to another location.

SMTP Server/
IP Address - The address of the SMTP server that will be used to send the logs
Email Address - The email address to which the logs will be sent.

Click on Send Mail Now to send the email.
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Using the Configuration Menu (continued)
Status > Stats
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The screen above displays theTraffic Statistics. Here you can view the amount of pack-
ets that pass through the DI-624+ on both the WAN and the LAN ports. The traffic
counter will reset if the device is rebooted.

Status > Wireless

High-Speed zmumsml
DI-624+
‘ | Hnme ﬁdvumEd ' s - SHIIE .h'! l“
This Wireless Cliert fable below desplays Wiebess clients Connacted 1o the AP 0
- {Bccess Point). o
Connected Time T
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Wireless

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless
client.

Click on Help at any time, for more information. 38



Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking

computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Metwork Setup Wizard

Welcome to the Network Setup
Wizard

Thiz wizard will help you set up this computer b wn an your
nietwork, With a network, you can:

Share an Intermet connection

Set up Internet Connection Firewall
Share files and folders

Share a printer

LI I I ]

To continue, click Mext.

[ Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Metwork Setup Wizard
Before you continue. .. %

Before you continue, review the hecklist far greating a netwark.

Then, complete the following steps:

* Install the network cards, modems, and cables.

+ Turn on all computers. printers, and external modens.
+ Connect to the Intermet.

When you click Mest, the wizard will search for a shared Internet connection on your network.

’ < Back I Mest » II’ Cancel ]

Click Next

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Network Setup Wizand
Select a connection method. %

Select the statement that best descrbes thiz computer:

() Thiz computer connects directly to the Intemet. The other computers an my network connect
to the Internet thraugh this computer.

Wiew an examples.

(®)iThiz computer connects to the [ntemet through anather computer on my network or through
regidential gateway,

‘iew an example.

() Other

Learn more about home ar small office network configurations,

pr—
£ Back Il__ﬂext) ll[ Cancel
S —

Click Next
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Network Setup Wizard
Give this computer a description and name.

[Qomputer descrphion: Mary's Compuiter

—_

Examples: Familp Room Computer or Monica's Computer

[ Carnputer name: Office ]
Examples: FAMILY or MONICA

The current computer name iz Office

Learn mare about computer names and descriptions.

RN T

Click Next

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Network Setup Wizard

Mame your network.

Mame pour netwark. by specifying a workgroup name below. All computers on your network
should have the same workgroup name.,

work group name: | Accounting

Eiamples HOME of OFFICE

< Back Mext » Cancel

Click Next



Networking Basics

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network zettings...

The wizard will apply the following settings. Thiz process may take a few minutes to complete
and cannot be intermipted.

Settings:
Metwork settings: ~
Computer description: Mary's Computar
Computer name:; Office
Wiarkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
w

To apply these settings. click Mewt.

[ < Back I Mext > i[ Cancel
S——

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Metwork Setup Wizard

Please wait... %

Flease wait while the wizard configures this computer for home or small office netwarking. Thiz
process may take a few minutes,

¥ 2




Networking Basics

In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizand

You're almost done...

2 You need to run the Metwork Setup Wizard once on each of the computers on your
‘y retwork. To in the wizard on computers that are not running 'Windows =P, you can uze
the Wwindows <P CD or a Metwork Setup Disk.

What do you want to da?

(®iCreate a Netwaork Setup Disk!

(0 Use the Netwaork Setup Disk | alieady have
(O Use my Windaws <P CD

(O Just finish the wizard; | dont heed ta run the wizard on other computers

oo )

Insert a disk into the Floppy Disk Drive, in this case drive A.

Network Setup Wizand

Inzert the dizk you want to use.

Inzert a dizk the into the following disk drive, and then click Mest.

3% Floppy (&)

If you want to format the disk, click Format Disk.

Click Next.
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Networking Basics

X

Copying. ..

L/ et

Flease waik while the wizard copies files., ..

[ ]| Zancel |

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network

Setup Wizard once on each of the computers on your network. To continue click Next.

Network Setup Wizand
To run the wizard with the Hetwork Setup Disk_ .. %

= Complete the wizard and restart this computer. Then, uze the Metwork Setup Dizk to run
\!J) the Metwark, Setup Ywizard once on each of the ather computers on your network,

Here's how:

1. Inzert the Metwork Setup Dizk into the nest computer you want to network,
2. Open My Computer and then open the Metwork Setup Disk.
3. Double-click "netsetup.”
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Networking Basics

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Network Setup Wizand

Completing the Network Setup
Wizard

You have successfully zet up thiz computer for home or zmall
office networking.

For help with home or zmall office nebworking, see the
fallawing tapics in Help and Support Center:

+ Uszing the Shared Documments folder
+ Shanng hles and tolders

To see other computers on your netwark, click Start, and then
click My Metwork Places.

Ta cloze thiz wizard, click Finish.

| <Back || Finsh |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change

P You must restark your computer before the new settings will take effect.

Do you wank to restart wour computer novy?

[ ves [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network
Setup Disk on all your computers, your new wireless network will be ready to use.
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Networking Basics
Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen)

B Right-click on My Computer

B Select Properties and click

.\ Internet
Inkernek Explorer

&5 E-mail

J Outlook Express
S _cmimand Prompk
\! MSM Explorer
(.') windows Media Playver
=
\,{m wwindows Movie Maker
@ Tour Windows ¥P

« % | Files and Settings Transfer
s SWizard

._) My Documents
A
z} My Recent Documents »

:‘) My Pictures
]

< My Music
y My Computer |
Open

‘-; My Network  Explore
Search...
B} Control Panel  Manags
Map Metwork Drive. .,

e\ Connect To
=]

':;é Printers and F

Disconnect Metwaork Drive, ..

Show on Deskkop
Rename

B Select the Computer
Name Tab in the System
Properties window.

B You may enter a
Computer Description if

you wish;

optional.

this field is

B Torename the computer
and join a domain, Click

Change.

General H

System Properties

Femate

' Syst;am Fl-e-st

Computeriame )| Hadware | Advanced |

>

Computer description:

Windaws uzes the following infarmation to identify your computer
on the network.

For exarmple: "Kitchen Computer” or "Man's
Computer".

Full computer name:  Office

Workgroup: Accounting

To uze the Mebwork |dentification ‘wizard ta join a

; ; Mebwork: 1D
domain and create a local user account, click Metwork,
Torename this computer or join a domain, click Change.
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Networking Basics
Naming your Computer

B |n this window, enter the Computer, Hame Changes
Computer name

'ou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

B Select Workgroup and enter the
name of the Workgroup Computer name:

Office
B All computers on your network _
Full computer name:

must have the same Workgroup | = office

name.
B Click OK tember of
© Demain:
() workgroup:
Accounting

' oK I Cancel

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connectionicon .
Repair

in the task bar

Yiew Available Wireless Mebwarks

Open Metwark Connections

B Click on Status
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Networking Basics
Checking the IP Address in Windows XP

Wireless Netwaork Connection 7 Status E“z|

General |1 Support '

This window will appear.

Internet Pratocal (TCRARF)

| Click the :
Su pport tab Addrezz Type: Azzigned by DHCP
[ IP Address: 192.168.0.114 ]
Subnet tMask: 250,266 26610
Default Gateway: 192.168.0.1

getaﬂs

[ | Click Close

—
Close

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to assign
Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP
Address, please follow these instructions:

o ‘ '_l-" Control Panel
@ Tour Windows 5P

.::é Printers and Faxes
lg Pairit

n Go to Start

g) Help and Suppart
ﬂ Files and Setkings Transfer =
. Wizard :
B Double-click on - search
Control Panel
All Programs D i:j Run..,

ﬁ| Laog oFf |* | Turn OFF Camputer




Networking Basics

Assigning a Static IP Address in Windows XP/2000

B Double-click on
Network
Connections

B Right-click on Local Area
Connections

B Double-click on
Properties

B Control Pamal

Fla Edt Ue#  Fovories

Took  Halp

+] e EF | S swrch [ Fodew | [T

fuchiens | G Conktral FPangl
; - et ress billy Qptions
ekl Hardwars

LA oF Rerae Progeens
turmirsst skt e Toak

ﬁ" Control Panal

[} Sid teh b Cabagnry View

%, pprwmry Cannectizne

Rl EW Ve Fowbs Toos  ddveced HD
Qo O 3 e v [

Scickain B Metmae b Cormsctine:

B Setupahore o el
T et

A Divada tir retrar:
davim

%, Pt crratioo
‘ B Uhe DNeIs
& W st of Ha

W P s Hades
£ P Dececusaanid
& Meconrutm
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Networking Basics
Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

B Click Properties

H Inputyour IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
of 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

B Input your DNS server
addresses. (Note: If you
are entering a DNS
server, you must enter the
IP Address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)

B Click OK

—i- Local Area Connection 7 Properties

General | Advanced |
Connect using:

EJ  D-Link DWL-AB50

This connection uzes the following items:

. % Clignt for Microsoft Metworks

gFlle and Printer Sharing for Microzoft Metworks
Bl 355 Packet Scheduler

ﬁlnh—-rrn—-r Pratocol |

Instal..
D ezcription

Transmizsion Contral Protocol/Internet Protocol. The default
wide area netwark, protocol that provides communication
acrozs diverse interconnected networks.

[ Show icon in notification area when connected

Ok ] [ Cancel

Infernef Protocal [TCRAP) Properties

Gened |
w4 ran gt [P cettings sesigned sutomsticalp il woor network supports

Hre papabdly Oin s, pos need (o sk pouy nedrcrk sdministieho fo
tha appiopiak: IF setling:

) Oblar an IF addeaz sdomaicaly
) L= e Fobowi g P cidres s

IP adchers 1% .1e|. 0 2
Sibinat mesk R OEF ER 0
Dleizul gabewmr

(E s
Frelmsd DN ssresr 2 oo |
flimmals ONG e
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Networking Basics

Assigning a Static IP Address with Macintosh OSX

B Go to the Apple Menu and se-
lect System Preferences

B Click on Network

B Select Built-in Ethernet in the
Show pull-down menu

m Select Manually inthe Con-
figure pull-down menu

B Input the Static IP Address,
the Subnet Mask and the
Router IP Address in the ap-
propriate fields

B Click Apply Now

LT] [T
<« 2@ O
[ e
re

a8 o

W =A@ 3

W A Ceiplyi il Mok L DR

st TR AIVEIE b

Lecawon: | Auiomatic ¥}
Shos | Bul-in B e e 4!
aia
niEter
Coefigars  Lising DHCP |
ihirg Bostf
F Adimas
(hrwvcing iy Ol P Larveri

Subani Mank- 2552951550

Rouer 1ES1SAL1 eyl Rty

De#CF Tl B0
oy

Frampr arpds cors, coisbms o

LT P

() ke Tk W prece e enies dhanges

a8 [

W =A@ 4

e A eighyi il Wetecak 0L Db
Lecason: | Automatic +!

Shoss | Bul-in Eemer il

Cenfigure: | Baualp =

FAdéman  1R12E.02

Subani Mark- 255 155,255 .0

B TR Lkl Saunch Domem

N LS T LT

Demun Kame Sanver (g

sl

Frampir amoic cor, o ibns o

ElbaiTet =difidse [UPRNI T

(@) ke 1k 3 e fanlbes denges.




Networking Basics

Selecting a Dynamic IP Address with Macintosh OSX

(15 Tt rem g ey
A mae a
B  Go to the Apple Menu and select L -
System Preferences i =
s 2 /8% 3
B Click on Network sam9e @
2 a® @2
a8 LT =
h:.“ L\El 1.& Hgl. u:.%w\.
B Select Built-in Ethernet in the G P w
Show pull-down menu [ (grrrr— )
: mnu:rf : il
B Select Using DHCP in the
. ¥ Addran
Configure pull-down menu o o DS
Subrwt Bk 253 29% 2980
g ARG St Deniaing Ltk
A L
Wiowioral !
Inwrds dmss (oo, sa1hline s
Lrkarrat Addrn
"E" i b Do bepih B it Ba ity dhmaips
- 1:8 Wzl =

M Click Apply Now

B TheIP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds

- S H@ O

ham A pue Rasd Mdheih  Waen O
Lomaliomd | BAFK) S
Shaw- | Bali-in Ethames 3

Corfigare | Unneg CRCF

TP Ay TR TSR0 182
Pt Ly THEF e

Subeer Wk 255 255 2S00
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Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m Goto Start >Run >
type cmd. Awindow
similar to this one
will appear. Type
ping XXX.XXX.XXX.
XXX, where xxx is
the IP Address of
the Wireless Router
or Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me and
98

B Goto Start > Run P (=
> type command. i |
A window similar to
this will appear.
Type ping Xxx.
XXX XXX . XXX
where xxx is the IP
Address of the
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-624+ Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Note: Itis recommended that you use an Ethernet connection to
configure the DI-624+ Wireless Broadband Router.

1.The computer used to configure the DI-624+ cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-624+ is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that
the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-624. Please see Checking the IP Address in Windows XP in the
Networking Basics section of this manual.

Note: The IP Address of the DI-624+ is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the DI-624+ is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. A successful
ping will show four replies.

Note: If you have changed
the default IP Address,
make sure to ping the
correct IP Address
assigned to the DI-624+.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Disable
Status
Repair

Connect to Wireless Network

The following network(z) are available. To access a network, select
it fram the list. and then click Connect.

Available networks:

1 alan A

]

e ieEee e k oo
pen Metwork Conneckions _ default W
|
")

If you are having difficulty connecting to a network, click Advanced.

[ Connect ][ Cantcel ]

B Check that the IP Address assigned to the wireless adapter is within the

same IP Address range as the access point and gateway. (Since the
DI-624 has an IP Address of 192.168.0.1, wireless adapters must have an
IP Address in the same range, e.g., 192.168.0.x. Each device must have
a unique IP Address; no two devices may have the same IP Address. The
subnet mask must be the same for all the computers on the network.) To
check the IP Address assigned to the wireless adapter, double-click on
the Local Area Connection icon in the taskbar > select the Support
tab and the IP Address will be displayed. (Please refer to Checking the
IP Address in the Networking Basics section of this manual.)

If it is necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.

m Goto Start> My
Computer >
Properties

B Select the
Hardware
Tab

W Click Device
Manager

I
@ Windaws Media Player W
npen
Explone
G" Corkral B Sasedch,,
fEneps
& - ' k -
= riap meovanek Crese, .
z;ii‘ Prirpers ¢ SE0onnect Habeork, Deia,

1w S on Daskiop
'_‘Jl-ﬁ:..anj FErsms

_'-;JSM'I:h f Properties

F=IRun..

all Progeams [

El Liog CFF [@ Tum I Computer

14 start

System Properties

i. -S_l,lstem Restore I Autarnatic Upd

| General | Computer Mame

Add Hardware “Wizard
i The Add Hardware WwWizard helps you install hardweare.

Add Hardware ‘wizard

Device Manager

The Device Manager lists all the hardware devices installed
on your computer. Usge the Device Manager to change the
properties of any device.

A
[ Diriver Signing ] [( Device Manager ) ]

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

[ Hardware Profiles ]

[ 0k J[ Cancel ] Apply




Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but the
procedure will remain the
same.)

B Select Properties
to check that the
drivers are in-
stalled properly

B Look under Device
Status to check that the
device is working

properly

B Click OK

L Device Manager

File  Action Wiew Help
& @

= 1= pMTEST
+ a Eatteries
+ j Zomputer
+| g Disk drives
¥ } Display adapters
+|-4= Floppy disk controllers
+ g Floppy disk drives
+-4= IDE ATAJATAPT controllers
+- Keyboards
+- ") Mice and other pointing devices
- 3, Modems
+ i Monitors

A <na

B Mebwork adapters

=23 D-Link AirPlus DWL-G650
+- |8 PCMCIA adapters
+- 4 Ports (COM & LPT)
+ ﬂ Processors
+- %, sound, video and game controllers

¥ System devices
+ Universal Serial Bus controllers

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter Flr)?l

Ganaid | Acvarced | Setings | Orver | Rescuaces

ﬂ] D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Dy (ppe MHelyuork, sdepies
HWanfahas Ll

Lozsiot PLI b 5, cey e 0, funchon O

Devicn s

h"ﬁ l‘iﬁ“W L Wl"!;l LAl

It pou ek basing pioblens mith this dewves, chok Tioublesoot 1o
stail 1he moublsshooter.

Temideshoot

Do minage:
U thiz dovine [zeatlz] a

' K, ' Cancel ]
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-624+. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-624+, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11b, the Encryption settings are: 64, 128, or 256 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-624+ and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-624+ and the client. Turn the DI-624+ back on again, and then turn
on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramati-
cally or drop altogether. Try changing the Channel on your DI-624+, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

7. 1 forgot my encryption key.

Reset the DI-624+ to its factory default settings and restore the other devices on

your network to their default settings. You may do this by pressing the Reset

button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-624+ to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-624+ to the factory default settings. Remember that D-
Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the DI-624+ to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-624+
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the DI-624 reboots (this may take a few minutes) it
will be reset to the factory Default settings
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Technical Specifications

Standards
B |EEE802.11g
m IEEE 802.11b
m IEEE802.3
m IEEE 802.3u
VPN Pass Through/ Multi-Sessions
H PPTP
B L2TP
m |PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6 or
later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

B NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
B Outdoors — up to 1312 feet (400 meters)

Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
B FCC

Wireless Frequency Range:
B 2.4GHzto 2.462GHz
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Technical Specifications

LEDs:
Power

WAN
LAN (10/100)

WLAN (Wireless Connection)
Status
Physical Dimensions:

B L =7.56Iinches (192mm)

B W =4.65inches (118mm)

m H=122inches (31mm)

Wireless Transmit Power:

B 11g:14dBm Typical

11b: 16dBm Typical
Security:

B 802.1x
B WPA- WiFi Protected Access
(64-,128,256-bit WEP with TKIP, MIC, IV Expansion, Shared Key
Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
B Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 2.5A

Weight:
m 10.8 oz. (0.3kg)
Warranty:

m 3 year (depends on D-Link global warranty policy)

62



Technical Specifications

Wireless Data Rates with Automatic Fallback:

Receiver

54 Mbps

48 Mbps

36 Mbps

24 Mbps

22 Mbps

18 Mbps

12 Mbps

11 Mbps

9 Mbps

6 Mbps

5.5 Mbps

2 Mbps

1 Mbps

Sensitivity:

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
22Mbps PBCC, 8% PER, -80dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-624+ (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in
to a ROM chip in the device itself. Your computer must be on the same IP subnet to
connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 toDWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. .. 1 White.Green
define the wiring standards and allow for z Braaa:
two different wiring color codes as S Rien-nge
illustrated in the following diagram. g E‘;::;fluﬂ
. . T White-Brown
*The wires with colored backgrounds may & Brown

have white stripes and may be denoted 568A CABLE END
that way in diagrams found elsewhere.

;_ "Sﬂrils-ll.'llunga
How to tell straight-through cable from 3 VWhite Creen
. 4 Blue
acrossover cable: . e
The main way to tell the difference & Green
between the two cable types is to compare £ Eiiislimen

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5608 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends
A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings. e v b e
(280 9
Go to Start>Settings>Control Panel. Double click PR |
the Internet Options Icon. From the Security tab, s i PR
click the button to restore the settings to their "R e
defaults.
s e
I S 1 |
.!‘h':'m- "‘"_a' I
Click to the Connection tab and set the dial- “”li""'"_" i
up option to Never Dial a Connection. Click T ]
the LAN Settings button m -
i ]
T gl
[ |
1o e e B S BIF]
e e e i
Nothing should be checked. Click OK [

r mm-hmmﬁmi'-u

Go to the Advanced tab and click the
button to restore these settings to their

defaults

Click OK. Go to the desktop and close any open
windows




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range of the device you are attempting to configure. Most D-Link devices use the 192.
168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.

) Tope the name of & piogram, bode), or docurent. ard
X Sfirchonas: wall g it for poiy

[ =]

nni Cancel | Browes |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

Ly |F Comifiguration

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.
Step 2 Type cmd then click OK.
Run 23

- Tvpe the name of & program, Folder, document, or
Internet resource, and Windows wall open & For you.

Open: | omd W

I K, H Zancel |l Browsse. .. |

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

0H [Wers it
A Hicre:

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?
Step 1

Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007

. - 4
Step 1 Right-click on My Network T — e _
Places and select Properties. | orrT—e— ’:’
o IR -
Step 2 Right-click on the Local etk snd piatus -
Area Connection which represents —
your network card and select 4 -
Properties. MR
[T — kIFT
Garmsdl |
Comct song

|~ Lk 0 £ 500 010 it & . Aickapiar
Comreorent: checked 22 ared by the comedian.

."Hrn.f;rnun P e e——" =l
W Hememt Mo (e

Highlight Internet Protocol (TCP/

IP) and click Properties. *I“m | I_J
b | id | e |
Dl

Tirmrrmatio oetid Pratsonbinssne Sunmal The defad
e it e . ol i W e 8 e
o S e S BT

B oy iaon in sk Des b comresnasd

| o |
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007?

(continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose is
not in use on the network.

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Intemet Pratacod { TCP/ 1P ) Propertaes

Gurmadi |

i Lt g 1P B SIgRa AN SRR I a i el SO0
e caguate,
e mppaopainis P jelings

1=

iy Chhapaie, po e b sch, pour massore ackerrriada e

" Dbl an P addens subomsbrals

7 Ligw thw Fodoeng IP scddery

7 soidanz | %25k B &
e Wk, | 6.5 2% D

et iy B

A

g e Floesing DT peres poiiesiast

Set the Primary DNS to be the same as

Fraiaved OFS datos == o
baram DHE savar ETETEEE
Ao
[

the LAN IP address of your router (192.
168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding” for
each adapter. Highlight TCP/IP > (your
network adapter) and then click

Properties.

Corbguaties |1 dystdaters | oo Corisi|
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 98/

Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address 192.168.
0.X where X is between 2-99. Make sure that
the number you choose is not in use on the
network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the
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web management. Follow instructions to login and complete the configuration.



Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). il
fr» FASBGE Ny O 1ol T o] Dbl

Step 2 Click the Home tab and click the s 152 1601

WAN button. Dynamic IP Address is the Bew DI

default value, however, if Dynamic IP Address Uses biawe i

is not selected as the WAN type, select Eavnd |

Dynamic IP Address by clicking on the radio [ T e

button. Click Clone Mac Address. Click on [

Apply and then Continue to save the

changes.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** |f you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by

typing in the IP Address of the router (default:192.168. [ -
0.1) in your web browser. The username is admin (all T e
lowercase) and the password is blank (nothing). e ke

pmlen fare

e [
Step 2 Click the Home tab and click the WAN ] o= |
button. Select Static IP Address and enter your static
settings obtained from the
ISP in the fields provided.

DLtk AR
If you do not know your — High-Tpoed 0N itiele Doater
settings, you must contact ‘-:I Homa _ Slalus | lielo |
yOUI’ ISP Plaams naluci 1he appoprmie optiaa Iz corract a yee EP

i I siapl" i e

r PEFeE f e 52 ees FPP0E (Fri eae

Step 3 Click on Apply and Wi oo FIF e o
then click Continue to save S —— BRI e
the changes. o | S '

E F fedduis w-nq-u B yoat 5P
Step 4 Click the Status tab R
and click the Device Info it - S
button. Your IP Address T T
information will be displayed
under the WAN heading. 4 90




Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://mwww.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

a_nd enter the 1P AddreSS Of yOur Virbual Sarver is used ko allow Inkeenst users accass 1o LAN samices
D-Link router (192.168.0.1). ey e
Enter username (admin) and - e Cleer
your password (blank by S T =t
default). Pamtoel Type  [LUDP =

Fewals Pon =7

Step 2 Click on Advanced on Pl Pt B
top and then click Virtual i & tine

Server on the left side. £ Froen time [003] - [00 2] [W2 2] 1o [0 50 . [ 3 A =

Step 3 Check Enabled to 4oy [Sn =] e Ein 2]
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure,
select both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure 1
of the web servers to use port 81. Now you can open port 80 to the first computer and
then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a server
that has company data. (The term comes from the geographic buffer zone that was set
up between North Korea and South Korea following the UN police action in the early
1950s.) ADMZ is an optional and more secure approach to a firewall and effectively
acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up a

DMZ

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address of the
router (default:192.168.0.1) in your web
browser. The username is admin (all
lowercase) and the password is blank

(nOthing) Access Point
User name: [ ﬁ admin |

Passward;

[l pemember my password

[ [e]4 l [ Cancel

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

D-Link

Bl fvw] Metwericd for Peagie

AirlPlus G

High-Speed Z.4GHz Wireless Router

Step 4 Click Apply 6% | [_tiome JFVRVCUIN Tools = Status 0 Help
and then Continueto
save the Changesl - ::II:E'_IEI-;:':\IHEII:N Zoae) is used b Sow & singe ¢ omguler an (ha LAY o be exposed 1
iUl Barver
© Enabld # Disabkad
Note: When DMZ is Pamwess

enabled, Virtual Server
settings will still be
effective. Remember,
you cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server settings
will take priority over

DMZ settings.

L

|

Ild
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-624+ using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on
Enabled and type in
a name for the new
rule.

Step 4 Choose WAN
as the Source and
enter a range of IP

;-th'r}l:l: lus o

Firesall Rulis can ba used ba allow or dany 1refic fom passng theaugs The DHE2S+

" Enabled T Dmmabisd

L F—

Actisn & Al © Deny
Addresses out on the - i:l-.-f::;lr-’m:-e St Ir Rasgr End  Prstocdl Forl Fange
internet that you o - F A — .

would like this rule
applied to. If you

Schedule T Awaps
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would like this rule to P ER T B

allow all internet 2 90
Apghy Cancal Hel

users to be able to Actian Hame Saurs Destination Profecsl :

access these ports,
then put an Asterisk
in the first box and
leave the second box

empty.

DI-624+ |
)
=

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure 1
of the web servers to use port 81. Now you can open port 80 to the first computer and

then open port 81 to the other computer. 79



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

Server IP Enable

table:

21
80
1723

192.168.0.5 X
192.168.0.6 X
192.168.0.7 X

How do | use PC Anywhere with my DI-624+ router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP
is the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 The first entry
will read as shown here:

Step 5 Click Apply and
then click Continue.

‘Wirtuad Seevar is used to sllow Infemat users access 1o LAN sanices.

# Enabled © Dizablag

Marne [pamashers=1 Claar
Privale IP [ieeieeoion

Protocal Type m

Prvste Pat [2

Pubdic Port ]22_

Schedule ' Always

* From Ilmam M|ﬁqu:|ﬂu_ﬂ [00 =] [4m =]
d:fmlulﬂuﬂ b
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-624+ router? (continued)

Step 6 Create Wi S
a second entry irtual Senvar is used to allow Intemet users access 1o LAN senices

as shown here:

# Enabled T Disabled
Nama [peammwhers? Clear
Private [P 192 1660100

Pratacol Type | TCR =

Prvate Fort BB

. Fubfic P BRI
Step 7 Click il ot B
Apply and then Schadula # Ahways
click Continue. ¢ From time [00 =] . [00 =] [AM =] 1o [00 =] . [00 =] [Am =]

.jaa_l.|5un 'ri 1 | Sun 'I

Virtual Sercar

Step 8 Create ) .
a third and final Vitual Saner iz used fo allaow Infamet users access to LAN sandces.

entry as shown

i & Enabled © Digabled
here:

MName |;Jr:&n3..'|'-hereﬂ Clear
Brivate IP 182.168.0.100

Frotocal Type  [UDP 7]
Private Port  [5632
Public Pot  [5632
Schedule & Mhays
© From time |00 =] |00 =} [aM =] 1o [00 =] . [00 =] |am =]
day[Sun =] ta[S0n ]

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address. 81



Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router (192.168.0.1).
Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a ——
new firewall rule: Aﬂ""gllll o

Click Enabled. High-Speed 2.4GHz Wirsless Router
Enter a name Di-624+ 2
' ™ ome I ook Siome " oo |
(edonkey). L
CIICk AI IOW . Flizsadl Rules can he usad o alkret or deng rafic foes passing aoegh the DEG2+
Next to Source, @ & Ensblad © Disabled
select WAN under Mome  [facdarkuy Cleat |
interface. In the - e 20w ek e R
. meTace IPRanps San P Range End Froiecel  Pon Range
first box, enter an E T | § F
* Leave the E Dewimation [LN = [oziGa o0 | | | I
Schidule & Aty
Z?ncgtr)]/d PO [ Firewoll e From tima [00 2] . [0 2] [am =] o [0 ] - oo =] [ =
. dap |Sun =] o |Sun *
Y-
Destination, Apeity Conewl Heln
select LAN under rm— Action e Suwce Destnslion  Protncal 4
. F Alliw Bisw 10 Ping WA WEN" L&H IEF1Ea 01 ICHF
T}terfacz.(jEnter f otk B 2 i
the IP Address o F Allw Dieiwit Lanz o 1P
the computer you
are running
eDonkey from.

Leave the second
box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first

box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 27?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

“iual Seree in vsad io ollow inbomel usan soness fa LAN serdnes

i Ensbled © Dtsabded

hame farom ﬂ
N X

Frotog ol Typs m
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Apply Cancel Help
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T Wil Eared HTTPS ooog TOF 44343 b )]
[ Winual Sawer DHG o.0o0g VoF SR iy Al

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply and
then Continue. 83




Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.

Step 4 Click Enabled and enter
Settings:

NAME - Gamespyl

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783
SCHEDULE - Always.

Click Apply and then continue

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy2

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.
Click Apply and then continue.
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Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

[_Home JWYZIVIN Tools  Status  Help |

“inual Server is used to allow Interned users access to LAN senaces.

= Enabled © Disabled

Mame [kazas Clear I
Prvate IP 192 .168.0.100

Prodocol Type |TCF =

Priwate Port 1314
Publc Pon 1214
Schedule = Always

© From time [00 =] - |00 =] |40 =] 10 |00 =] - [00 =] [am =]
da}-ISLrl'l *I!u un "]

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624,

DI-754, DI-764, or DI-774: w
’ ’ M]E'"‘ =
wmu&

Step 1 Open your web browser
and enter the IP Address of your ==t B

router (192.168.0.1). Enter
username (admin) and your
password (leave blank).

Wil S in et 10 B0 INNSH L 2R I LAK sever

Step 2 Click on Advanced and
then click Virtual Server.

Step 3 Create a new entry: Click — [=ass
Enabled. Enter a name

(warcraft3). Private IP - Enter the

IP Address of the computer you

want to host the game. Select

Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that you
are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other h.
323 software packages.

The solution is to put the router in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide H.
323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.

iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router (192.168.0.1).

Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new

firewall rule:

Click Enabled.
Enter a name
(ichatl).

Click Allow.

Next to Source,
select WAN under

interface.
In the first box,
enter an *.

Leave the second

box empty.
Next to
Destination,

select LAN under

interface.
Enter the IP
Address of the
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computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

W —Afr}glt._ - .‘
Step 4 Click Apply High-Speed 2.4GHz Wirsless Router

and then Continue.

Step 5

Repeat steps 3 and 4

enter ichat2 and
open ports 16384-

16403 (UDP).
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then

Virtual Server. Q;_I;‘jj,}m]f, AlrPlus =
High-Speed ZAGHz Wircles Router
Step 2 Check Enabled - - o]
to activate entry. hdvanced [T T T
il S B veed 1 i indera e urs Ger i 18 LAN sereoan

Step 3 Enter a name for

A | Crabded © Diabied

H s ] Diwa
3(1(;;1]; \t/ér)tual server entry e TEETE—
. Proiccol Type  |1CF 3
Eraes o ]

Step 4 Next to Private

Pubdic Ped BT

B’

IP, enter the IP Address Schebie M
of the computer on your T Fam I:%@%mmm | o
local network that you TS
yvant tg allow t_he S 00
incoming service to. _ Agply Cancel Hel
MaTe Pyt 1P Prdornl Sehmdak

- | -.'fru:r 51514:”"’ opno :i='.'l':l Fwass JEI

Step 5 Select TCP fOf I Vifus Seser ETIP oooo jeog: I%: 1] Yy A

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:

- Serial number of the unit
- Model number or product name

- Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

D-Link or its authorized reseller or distributor and

Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below
will be free from material defects in workmanship and materials from the date of original retail purchase
of the product, for the period set forth below applicable to the product type (“Warranty Period”), except
as otherwise stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

Hardware (excluding power supplies and fans) Three (3) Years
Power Supplies and Fans One (1) Year
Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-conforming
Software, the price paid by the original licensee for the non-conforming Software will be refunded by D-
Link; provided that the non-conforming Software (and all copies thereof) is first returned to D-Link. The
license granted respecting any Software for which a refund is given automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the warranty
service is provided.

After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do not include any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the property
of D-Link. Products shall be fully insured by the customer. D-Link will not be held responsible
for any packages that are lost in transit to D-Link. The repaired or replaced packages will be
shipped to the customer via UPS Ground or any common carrier selected by D-Link, with
shipping charges prepaid. Expedited shipping is available if shipping charges are prepaid by
the customer and upon request.

Return Merchandise Ship-To Address
USA 53 Discovery Drive, Irvine, CA 92618
Canada: 2180 Winston Park Drive, Oakuville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined by
D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KINDWHATSOEVER INCLUDING,
WITHOUT LIMITATION,ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
ANDNON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTIONAND PERFORMANCE OF THE PRODUCT IS
WITHTHE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDERANY CONTRACT,NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUTNOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICHD-
LINK’S PRODUCT IS CONNECTEDWITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON,
ORINTEGRATEDWITHANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEENADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FOR ABREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR,REPLACEMENT ORREFUNDOFTHEDEFECTIVE ORNON-CONFORMINGPRODUCT. THEMAXIMUM
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LIABILITY OF D-LINK UNDER THISWARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVEREDBY THEWARRANTY. THE FOREGOING EXPRESS WRITTENWARRANTIESANDREMEDIESARE
EXCLUSIVE ANDARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communication. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.

Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized
modifications to this equipment; such modifications could void the user’s authority to operate the
equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. The antenna(s) used for this equipment must be installed to provide a separation
distance of at least eight inches (20 cm) from all persons.

s

This equipment must not be operated in conjunction with any other antenna.

( Register your D-Link product online at http://support.dlink.com/register/ J
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